General Ledger

VLookup

When you use a lookup function in Excel, you are basically saying, “Here’s a value. Go to another location and find the same value. Then show me specific information related to that value.”

You work for the Zoology. Zoology uses the generic activity codes in Oracle to analyze certain types of activities. You prepare some data for the department head and you would like to replace the generic Oracle activity names (e.g. Program C) with the department assigned names.

First we will need to open our data files.

1. Click on the **Office Button**.

2. Select **Computer**, then under **Network Location** select Classroom Share or Hearth Room Share

3. Go to the desktop and locate the folder Data for Excel 2010 class.

4. Open the **GL Data Folder**.
5. Open the file Vlookup_Hlookup.xlsx.
   
   a. Be sure you are on the VLOOKUP tab.

6. Now open Activity Codes.xlsx.

7. The worksheet should look like this.

   a. This file contains the actual Department Names associated with the generic Activity Codes from Oracle.

8. Go back to the Vlookup_Hlookup.xlsx file.

9. If you look at the column titled “Activity Name” you see the generic Oracle names. What we want to do is replace the generic names with the department assigned activity names.
10. Because this worksheet contains query results extracted from the Data Warehouse, there are two formatting issues that must be resolved before doing a VLookup.

   a. Be sure you are on the **VLOOKUP** tab in the Vlookup_Hlookup.xlsx file. We will be doing the VLookup in the column titled **Activity Name**. The formatting of this column must be changed to General.

   b. Highlight the column **Activity Name**.

   c. On the Home tab, in the Number group, click on the down arrow in the field that shows “General”.

   d. Select “General” from the list of formats. General only shows in the panel because it is the first selection from the list.

   b. The Activity number is the link between this query in the Vlookup_Hlookup file and the Activity Codes file. The Activity Number in both files must have the same formatting.
i. The Activity Number in this query is text as indicated by the little diamond on the left top corner of the cell.

![activity number image]

ii. The Activity Code in the Activity Codes file is numeric.

![activity codes file]

iii. In the VLOOKUP tab, place the cursor on the first activity code under Activity Number.

![vlookup activity number]

iv. Notice the little square that appears to the left of the cell containing a diamond shape with an exclamation point inside.

v. Highlight the rest of the column by either dragging the cursor down or clicking on the down arrow while pressing Ctrl/Shift.
vi. Use the scroll bar on the right to move back up to the top of the column. Click on the little square with the exclamation point to the left of the first cell.

![Image of Excel spreadsheet with a cell selected]

vii. Select the **Convert to Number** option from the list.

![Image of Excel spreadsheet with a cell containing VLOOKUP formula]

viii. The Activity Number is now numeric and the text indicators are gone.

11. To begin the VLookup, place the cursor in the first cell under the column heading **Activity Name**. The cursor is placed here because we are going to replace the generic Activity Name with a specific department assigned name.

![Image of Excel spreadsheet with formulas applied]

12. Open the **Formulas** tab on the Ribbon.

13. Click on the **Lookup & Reference** Category in the Function Library.
14. A list of available functions will display. Select **VLOOKUP**.

15. The **Function Arguments** Window opens. Beginning of the formula is displayed in the selected cell.

16. The **Lookup_value** is the value that ties our data file to the **Activity Codes** file. The **Lookup_value** is the Activity Number because we want to retrieve the activity description for each Activity Number. The Activity Number exists in both the data file and the Activity file. Note: the column headings do not have to match.
17. While you cursor is in the **Lookup_value** field, click on the first under the column heading **Activity Number**. (Note: the Activity Number should be in the same row).

18. Click into the **Table_array** field. The table array is the table of information containing the data we want to retrieve into our worksheet.

19. The definition shown now changes to **Table_array**.

20. With your cursor sitting in the **Table_array** field, switch to the **Activity Codes** worksheet.
21. The Function Arguments window remains.

22. The column with the Activity Code Number must be the first column in the array. The Activity Code is in column B in this worksheet.

23. Click on the column designator (B). The cursor becomes a black down arrow.

24. The department names for the activity codes are in column D. Drag the arrow to column D.

25. A dotted line appears around the selected data.

26. Excel places the name of the file, worksheet, and the columns selected into the Table_array field. The symbol next to the field indicates a list of values.
27. Count the number of columns from the column with the activity code numbers to the data you desire. Activity code is Column 1 in our array and Department Name is Column 3.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Activity Code (Num)</td>
<td>Oracle Name</td>
<td>Department Name</td>
</tr>
<tr>
<td>8/1/2006</td>
<td>201</td>
<td>Program A</td>
<td>Ant Races</td>
</tr>
<tr>
<td>8/2/2006</td>
<td>202</td>
<td>Program B</td>
<td>Lion Leaping</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>203</td>
<td>Program C</td>
<td>Monkey Business</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>204</td>
<td>Program D</td>
<td>Going Gorilla</td>
</tr>
<tr>
<td>7/1/1999</td>
<td>205</td>
<td>Program E</td>
<td>Bee Buzzing</td>
</tr>
<tr>
<td>5/1/2001</td>
<td>210</td>
<td>Program J</td>
<td>Fossil Taxiing</td>
</tr>
<tr>
<td>2/2/2008</td>
<td>215</td>
<td>Program O</td>
<td>Dippy Doodle</td>
</tr>
<tr>
<td>5/1/2004</td>
<td>220</td>
<td>Program T</td>
<td>Cat Care</td>
</tr>
<tr>
<td>2/2/2008</td>
<td>221</td>
<td>Program U</td>
<td>Cage Cleaning</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>225</td>
<td>Program Y</td>
<td>Banana Peeling</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>226</td>
<td>Program Z</td>
<td>Peanut Collecting</td>
</tr>
<tr>
<td>2/2/2008</td>
<td>233</td>
<td>Special Event C</td>
<td>Bring your pet to work</td>
</tr>
<tr>
<td>2/3/2008</td>
<td>261</td>
<td>Student Activities A</td>
<td>Carnival Petting Zoo</td>
</tr>
</tbody>
</table>

28. Click into the Col_index_num field. Excel returns to the Vlookup worksheet.

29. Enter a 3 in the Col_index_num field. At this point you will know if your VLookup will be successful.

30. Excel will preview the result for you.

31. Click into the Range_lookup field. The choices of entry are True (1), False (0) or omitted.
   - True (1) or Omitted – if lookup value is not found in the table array, it uses the next largest value that is less than or equal to the lookup value.
   - False (0) – Looks for an exact match to the lookup value. If not found, the #N/A is returned.

32. We want an exact match so enter the word false or the number 0 (zero).
33. Click on the button.

34. The generic activity name has been replaced. Look at the formula bar to see the calculation created using the arguments entered.

\[
\text{\texttt{=VLOOKUP(12,['Activity codes Excel 2007.xlsx']Sheet1!'$B:$D,3,0)}}
\]

35. The next step is to copy the formula down the column for all rows.

36. What do you suppose #N/A means? That is an indication that Excel was unable to find a match in the Activity Codes file. In the screenshot above, we have an N/A for both activity 206 and 209. Two reasons could explain why this happened.

   a. Someone used the wrong activity code.
b. The activity code was not added to the activity codes file.

37. Switch to the **Activity Codes** file.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Activity Code (Num)</td>
<td>Oracle Name</td>
<td>Department Name</td>
</tr>
<tr>
<td>8/1/2005</td>
<td>201 Program A</td>
<td>Ant Races</td>
<td>Ant Races</td>
</tr>
<tr>
<td>9/2/2006</td>
<td>202 Program B</td>
<td>Lion Leaping</td>
<td>Lion Leaping</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>203 Program C</td>
<td>Monkey Business</td>
<td>Monkey Business</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>204 Program D</td>
<td>Going Gorilla</td>
<td>Going Gorilla</td>
</tr>
<tr>
<td>7/1/1999</td>
<td>205 Program E</td>
<td>Bee Buzzing</td>
<td>Bee Buzzing</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>210 Program J</td>
<td>Fossil Tossing</td>
<td>Fossil Tossing</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>215 Program O</td>
<td>Dippy Doodle</td>
<td>Dippy Doodle</td>
</tr>
<tr>
<td>5/1/2004</td>
<td>220 Program T</td>
<td>Cat Care</td>
<td>Cat Care</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>221 Program U</td>
<td>Cage Cleaning</td>
<td>Cage Cleaning</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>225 Program V</td>
<td>Banana Peeling</td>
<td>Banana Peeling</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>226 Program W</td>
<td>Peanut Collecting</td>
<td>Peanut Collecting</td>
</tr>
</tbody>
</table>

38. As you can see from the **Activity Codes** file, activity code 206 is missing. Let’s add it. Since our VLookup searches for an exact match we can add the new activity code to the bottom of the list in the Activity Codes files.

39. Add the following to the Activity Codes list
   
   c. Creation Date – **Today’s date**
   
   d. Activity Code – **206**
   
   e. Oracle Name - **Program F**
   
   f. Department Name - **Lion Taming**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Activity Code (Num)</td>
<td>Oracle Name</td>
<td>Department Name</td>
</tr>
<tr>
<td>8/1/2005</td>
<td>201 Program A</td>
<td>Ant Races</td>
<td>Ant Races</td>
</tr>
<tr>
<td>9/2/2006</td>
<td>202 Program B</td>
<td>Lion Leaping</td>
<td>Lion Leaping</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>203 Program C</td>
<td>Monkey Business</td>
<td>Monkey Business</td>
</tr>
<tr>
<td>10/1/2007</td>
<td>204 Program D</td>
<td>Going Gorilla</td>
<td>Going Gorilla</td>
</tr>
<tr>
<td>7/1/1999</td>
<td>205 Program E</td>
<td>Bee Buzzing</td>
<td>Bee Buzzing</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>210 Program J</td>
<td>Fossil Tossing</td>
<td>Fossil Tossing</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>215 Program O</td>
<td>Dippy Doodle</td>
<td>Dippy Doodle</td>
</tr>
<tr>
<td>5/1/2004</td>
<td>220 Program T</td>
<td>Cat Care</td>
<td>Cat Care</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>221 Program U</td>
<td>Cage Cleaning</td>
<td>Cage Cleaning</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>225 Program V</td>
<td>Banana Peeling</td>
<td>Banana Peeling</td>
</tr>
<tr>
<td>2/1/2006</td>
<td>226 Program W</td>
<td>Peanut Collecting</td>
<td>Peanut Collecting</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>233 Special Event C</td>
<td>Bring your pet to work</td>
<td>Bring your pet to work</td>
</tr>
<tr>
<td>2/1/2008</td>
<td>261 Student Activities A</td>
<td>Carnivore Petting Zoo</td>
<td>Carnivore Petting Zoo</td>
</tr>
<tr>
<td>3/1/2010</td>
<td>206 Program F</td>
<td>Lion Taming</td>
<td>Lion Taming</td>
</tr>
</tbody>
</table>

40. Go back to the **VLOOKUP** worksheet.

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Activity Name</td>
</tr>
<tr>
<td>---</td>
<td>--------------</td>
</tr>
<tr>
<td>J</td>
<td>Monkey Business</td>
</tr>
<tr>
<td>206</td>
<td>Lion Taming</td>
</tr>
<tr>
<td>#N/A</td>
<td>Lion Taming</td>
</tr>
<tr>
<td>206</td>
<td>Lion Taming</td>
</tr>
<tr>
<td>206</td>
<td>Lion Taming</td>
</tr>
<tr>
<td>206</td>
<td>Lion Taming</td>
</tr>
</tbody>
</table>

41. The VLookup Function is a formula so it will automatically update when you make changes.

42. Go ahead and close the Activity codes file. Don’t save.
**HLookup**

HLookup provides the same function as VLookup, that is, it allows you to merge data from one file into another file as we did in the VLookup, or from one worksheet to another as we will do in this example. With HLookup we will be doing a horizontal lookup (in a row) whereas with VLookup we did a vertical lookup (in a column).

We are still working with our Vlookup_Hlookup.xlsx file.

Open the **Expenses by Category** tab.

This worksheet contains summary data by organization across Object Code rollups. If you are familiar with object codes you should recognize the values in the column headings are Parent values because they begin with a letter.

Now open the **HLOOKUP** tab.

This tab contains part of a report and we’ve been asked to provide the amounts. This example is quite simplistic but hopefully you will understand HLookup when complete.

In this worksheet the Organizations are in the columns and the Object Code Parent values are in the rows. Calculations have been inserted for the totals. We are going to use HLookup to complete this worksheet.

1. Be sure you are still on the **HLOOKUP** tab. Place your cursor on the first cell under the column heading for Zoology.
2. Open the **Formulas** tab on the Excel ribbon.

3. Click on the *Lookup & Reference* category in the **Function Library**.

4. Select **HLOOKUP** from the list of functions.

5. The Function Arguments window opens.
6. Look familiar? The Function Arguments is the same except the field Col_index_num is Row_index_num for HLookup. Look at the beginning of the formula displayed in the cell. It begins with HLookup.

7. With the cursor in the Lookup_value field, click on the parent value A8400.

Note: The Lookup value should be in the same row as the calculation.

1. The cell address has been placed in the Look_up field and to the right the actual value is displayed. Also notice that the cell address has been inserted into the formula.

8. Click into the Table_array field.

9. With the cursor still in the Table_array field, open the tab Expenses by Category.
1. The Function Arguments window should still be visible. Excel places the name of the tab ‘Expenses by Category’ in the field.

10. So with VLookup we highlight our Table_array by columns. In HLookup, we are going to do it by rows. Remember the look_up value must be in both worksheets/files and for HLookup, it must be the first row in the array. In this example, the Lookup_value happens to be in the first row of the worksheet.

11. Click on the row 1 designator at the left.

1. When you hover over the row one designator, the cursor becomes a very small black arrow and dotted lines appear around the first row.

2. When you see the arrow, press on your mouse and drag it down to row 4.
3. Dotted lines will appear around the rows and Excel places the designation of 1:4 into the field which means rows 1 through 4.

12. Before we click into the **Row_index_num** field, let’s determine what number should be there.

13. The first column in our report is for organization 391100.

14. In our Expenses by Category it is on the second row. Remember the first row is the row that has the Lookup_value in the table array.

1. In this example, row two of the array is also row 2 of the worksheet.

15. Click into the **Row_index_num** field. Excel returns us to the HLookup worksheet.
16. Type the number 2 into the **Row_index_num**.

17. At this point, we can see that our HLookup will produce result as Excel display a preview of the Formula result.

18. Click into the **Range_lookup** field. This field works exactly the same way as it does in VLookup. We want an exact match so enter a zero into the field.
19. Click on the [OK] button.

1. The amount is brought into the field and reflected in the total calculations.

20. What happens if we copy this formula to the next field?

21. So that doesn’t work. I guess we could create the formula in every cell that could be cumbersome and time consuming if we were working with a lot of data. Instead let’s go back and adjust our formula.

22. Be sure you cursor in the cell that contains the HLookup formula.
23. Click on the `fx` preceding the formula on the formula bar. This will open the Function Arguments window with entries still in it. We are going to modify the entries somewhat using the function key **F4** on your keyboard.

1. Let’s start with the **Lookup_value**. In the field we have A4. Aren’t all the lookup values in column A?

2. As we copy the formula across the columns, we want Excel to always look in Column A for the value, but as we copy the formula down we want Excel to increment the row. Therefore we want to make the column absolute or as I like to say ‘anchor’ the column. Click into the **Lookup_value** field.
i. Press the F4 function key on your keyboard.

\[
\text{Lookup_value} \quad \$A$4
\]

ii. A dollar sign appears in front of the column and the row. The dollar sign changes the designation to an absolute address, that is, it won’t change when it is copied to other cells. Having both dollar signs means that one cell is absolute so no matter where you copy the formula, Excel will look only in A4 for the value. This is not what we want.

iii. Press F4 a second time.

\[
\text{Lookup_value} \quad A$4
\]

iv. Now the $ sign only precedes the row. That means the row is absolute. That is still not what we want.

v. Press F4 a third time.

\[
\text{Lookup_value} \quad \$A4
\]

vi. Now the $ sign is only in front of the column which indicates the column is absolute but the rows are relative which means they will increment as the formula is copied down the column.

3. So to recap, the function key F4 is used to change a relative cell address to an absolute cell address as follows:
   i. Press F4 once - both column and row are absolute.
   ii. Press F4 twice – column is relative and row is absolute.
   iii. Press F4 three times – column is absolute and row is relative.

4. Click into the Table_array. Press F4 once.

\[
\begin{align*}
\text{Lookup_value} & \quad \$A4 \\
\text{Table_array} & \quad \text{Expenses by Category} \quad \$1:\$4
\end{align*}
\]

i. All rows are absolute which is what we want because all the data is in those 4 rows.

5. Click into the Row_index_num field.
i. Now this is something we cannot make absolute. If we copy the formula the row index will remain the same. Let’s have Excel help us out there.

ii. Click on the **OK** button to close the *Function Arguments* window with our changes.

24. Go to the Expense by Category tab.

<table>
<thead>
<tr>
<th></th>
<th>Organization</th>
<th>A8400</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>391100</td>
<td>788,341.81</td>
</tr>
<tr>
<td>3</td>
<td>391101</td>
<td>62,969.89</td>
</tr>
<tr>
<td>4</td>
<td>391102</td>
<td>39,525.43</td>
</tr>
<tr>
<td>5</td>
<td>Grand Total</td>
<td>890,837.13</td>
</tr>
</tbody>
</table>

6. Organization 391100 is on row 2; 391101 is on row 3; and 391102 is on row 4.

25. Let’s go back to our Hlookup.

1. The first row in this worksheet is blank.

2. Organization 391100 is on row 2 in the array table so type a 2 in the blank cell above org 391100. Type 3 and 4 above the other orgs as shown.

26. Place your cursor again on the first cell under Zoology where the Lookup formula currently resides.

27. Click on the **fx** again to open the formula once more.
28. Delete the number 2 in the **Row_index_num** field.

29. With the cursor still in the **Row_index_num** field, click on the number 2 in the field above organization 371100.

30. The location of the cell is placed into the field.

31. Let’s think about this. As we copy the formula across we want Excel to select the cell above the organization to get the correct row in the array table. As copy the formula down, we want Excel to always look in the Excel row one. That means we want the row to be absolute and the column to be relative.

32. Press the function **F4** on your keyboard twice.
33. Now click on the **OK** button to close the *Function Arguments* window with our additional change.

34. The formula now reflects the changes we made.

35. The last task is to copy the formula to all the applicable cells. Be sure not to overwrite the total calculation.

36. The grand total on this worksheet should match the grand total on the *Expenses by Category* tab.

37. Close the file *Vlookup_Hlookup.xlsx*. 
**Pivot Table**

A Pivot Table enables you to summarize large amounts of data in a matter of minutes. You can transform endless rows and columns of numbers into a meaningful presentation of the data.

Let’s assume you work for the Zoology department at Carnegie Mellon. The Zoology department consists of 3 organizations: Zoology, Anthropology and Paleontology. The department head has asked you to analyze how the department’s money was spent on operating expenses for Fiscal Year 2011.

**Starting with a blank Pivot Table**

1. Open the file `GL Pivot Table Data.xlsx`. The worksheet has a query containing FY11 expenses from the Financial Data Warehouse.

2. Place your cursor on any cell in the data.
   a. Important: Ensure your data is in a tabular layout and there are no blank rows or columns. Also, every column must have a unique heading that is one row high.

3. Go to the ribbon and open the **Insert** tab.
   a. Click on the **PivotTable** down arrow to get a list of options.
   b. Select PivotTable. –OR–
c. Click directly on the PivotTable icon to bypass the list of options.

4. The Create PivotTable window opens.

   ![PivotTable Window]

   a. Excel populates the Table/Range automatically.
   b. The default is New Worksheet under where to place the PivotTable

5. Accept the defaults by clicking on the OK button.

6. Excel inserts a new worksheet and places in it the tools you need to create your customized pivot table.

   ![PivotTable Tools]

7. Now look at the ribbon on top and to the right.
a. Two new tabs have appeared under PivotTable Tools; Options and Design. These tabs contain functions specific to Pivot Tables. The tabs are only visible when you are in the Pivot Table.

8. Let’s rename the worksheet tab for our Pivot Table.

a. Right click on the sheet name.

b. Select Rename from the list of options that appear.

c. The sheet name will become highlighted.

d. Type the label Pivot Table into the tab.

e. Click anywhere in the worksheet to exit the tab.

9. During this class we will be working on the PivotTable Field List but also in the Pivot Table itself.

**Pivot Table Field List**

10. Let’s take a closer look at the PivotTable Field List.

a. The top window contains all the column headings from the query. To choose a field for the PivotTable, you click into the box next to the field name.
b. The four smaller panes represent locations on the PivotTable.

c. The button at the top right gives you an option to change the configuration of the PivotTable field list.

i. The default is the Fields and Areas sections stacked.

ii. Fields and Areas Sections Side-by-Side.
iii. Fields section only.

iv. Area Section only (2 by 2).
v. Area Section only (1 by 4).

d. For class today, we will use the Fields and Areas Sections Side-by-Side, so we can see more of the field names.
Creating a Simple Pivot Table

1. Let’s start with a simple pivot table. Let’s summarize total expenses by Object Code Number. Click on the box next to the Object Code Number.

   ![Image of Object Code Number]

2. Selecting the Object Code Number caused the following to occur:

   a. The field name became bold as shown above.
   b. The field moved into the window pane named Row Labels.

   ![Image of Pivot Table with Object Code Number]

   a. A distinct list of object code numbers was placed in our PivotTable.

   ![List of Object Code Numbers]

2. Row Labels, Column Labels and the Report Filter typically are used for descriptive data.

3. To remove a field from the Pivot Table, I simply uncheck the box next to the field. Let’s check the box once again next to Object Code Number.
4. Let’s add some numeric data. Scroll down the list of field names and select Functional Net Activity.

   a. Functional Net Activity dropped to the values pane. This is numeric data which can be used in calculations such as summing. Summing is the Excel default because it is the most widely used.

3. Let’s format the dollar amounts so they are easier to read.

   a. Place the cursor on any dollar amount.

   b. Right click on your mouse. Select Number Format.
c. The Format Cells window opens. Select the Number Category.

d. Format numbers as shown above. Click on the OK button.

e. All amounts will be formatted.
You’ve completed your first analysis with a very simple pivot table. You now know how much your department has spent on operating expenses by object code. If you want to show this to your department head, he/she may not be familiar with the object code numbers. Let’s add a little more information to this table. This table might be more meaningful if we add the object code name.

**Adding another field to the Rows**

1. Select the Object Code Name by clicking on the box next to it.

![Object Code Name](image)

2. The object code name is now in the table.

**Removing Subtotaling**

As fields are added to the pivot table automatic subtotaling occurs. We can easily remove any level of subtotaling. For example, let’s remove the subtotaling by Object Code Number.

1. Right click on any Object Code Number.

![Subtotaling Options](image)
2. Uncheck Subtotal “Object Code Number” by clicking into the check box which removes the check.

<table>
<thead>
<tr>
<th>Object Code Number</th>
<th>Sum of Functional Net Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>84104</td>
<td>COMPUTING SUPPLIES</td>
</tr>
<tr>
<td>84106</td>
<td>OFFICE SUPPLIES</td>
</tr>
<tr>
<td>84108</td>
<td>PAPER SUPPLIES</td>
</tr>
<tr>
<td>84110</td>
<td>CLEANING/CUSTODIAL SUPPLIES</td>
</tr>
</tbody>
</table>

3. Object Code Number subtotaling has been removed.

**Not show subtotals**

Instead of removing the subtotals every time we add a field, we can elect to have the subtotals not show. Then we can individually select the fields on which we want to see the subtotals.

1. Go to the Pivot Table Tools on the Excel Ribbon and open the Design tab.

2. Layout is the first grouping on the Design tab.

3. Click on the little down arrow under the function Subtotals.
4. Select the option ‘Do Not Show Subtotals’.

5. Let’s add another field. Add Funding Source Number.

5. The subtotaling moves down to the Funding Source.

6. Remove the Funding Source Number from the Pivot Table by unselecting it.

**Moving Fields**

1. Let’s add the Organization Number to our Pivot Table. Click on the box to the left of Organization Number.

![Image of Pivot Table with Organization Number added]
2. The Organization Number in our data is a numeric field. Excel places all numeric fields automatically into the Values pane and sums it. Of course, this is not meaningful data for our analysis.

3. Let’s move the Organization Number to the Row Labels.
   a. You can Drag/Drop the Organization Number from the Values pane to the Row labels
   -Or-
   b. Go to the Organization Number in the Values pane and click on the down arrow to the right.
   c. Select “Move to Row Labels” from the options available.
   d. Organization Number is now in the Pivot Table.

4. I may want my dollars summarized by Organization first then Object code.
   a. Go to the Row Labels pane on the Field List.
b. Click on the down arrow next to Organization Number. Select “Move to Beginning” from the available options.

c. Organization Number is now at the top of the list and our Pivot Table looks like this:

5. I would think we would want subtotaling for the organization.

a. Right-click on the Organization Number.

b. Click on Subtotal “Organization Number” to turn subtotaling on.
Pivot Table Formats

Excel 2010 offers three different Pivot Table layouts.

1. Click on the **Design** tab under PivotTable Tools on the Excel ribbon.

2. In the Layout group, click on Report Layout.

3. The Layout choices will display.
4. The Pivot Table layout defaults to the Compact Form. In this layout, totals are displayed first and the detail follows.

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Sum of Functional Net Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>370100</td>
<td>1,146,744.12</td>
</tr>
<tr>
<td>84104</td>
<td>COMPUTING SUPPLIES</td>
</tr>
<tr>
<td></td>
<td>44,550.16</td>
</tr>
<tr>
<td>84106</td>
<td>OFFICE SUPPLIES</td>
</tr>
<tr>
<td></td>
<td>6,723.84</td>
</tr>
<tr>
<td>84108</td>
<td>PAPER SUPPLIES</td>
</tr>
<tr>
<td></td>
<td>6,562.69</td>
</tr>
<tr>
<td>84110</td>
<td>CLEANING/CUSTODIAL SUPPLIES</td>
</tr>
<tr>
<td></td>
<td>119.52</td>
</tr>
</tbody>
</table>

5. Select the second layout – “Show in Outline Form”. This format also displays totals first and then detail.

<table>
<thead>
<tr>
<th>Organization Number</th>
<th>Object Code Num</th>
<th>Object Code Name</th>
<th>Sum of Functional Net Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>370100</td>
<td>84104</td>
<td>COMPUTING SUPPLIES</td>
<td>44,550.16</td>
</tr>
<tr>
<td></td>
<td>84106</td>
<td>OFFICE SUPPLIES</td>
<td>6,723.84</td>
</tr>
<tr>
<td></td>
<td>84108</td>
<td>PAPER SUPPLIES</td>
<td>6,562.69</td>
</tr>
<tr>
<td></td>
<td>84110</td>
<td>CLEANING/CUSTODIAL SUPPLIES</td>
<td>119.52</td>
</tr>
</tbody>
</table>

6. Now let’s look at it in the Tabular Form. This form looks more like an Excel worksheet. The detail displays and then the totals.

<table>
<thead>
<tr>
<th>Organization Number</th>
<th>Object Code Num</th>
<th>Object Code Name</th>
<th>Sum of Functional Net Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>88830</td>
<td>IC MAILING SERVICES-UR</td>
<td>4,510.21</td>
</tr>
<tr>
<td></td>
<td>88835</td>
<td>IC PRINTING SERVICES</td>
<td>1,800.50</td>
</tr>
<tr>
<td></td>
<td>89000</td>
<td>FACILITIES &amp; ADMINISTRATION</td>
<td>141,587.37</td>
</tr>
<tr>
<td></td>
<td>89301</td>
<td>TRANSFER TO CLOSE SP DIRECT</td>
<td>5,609.48</td>
</tr>
<tr>
<td></td>
<td>89302</td>
<td>TRANSFER TO CLOSE SP F&amp;A</td>
<td>12,315.13</td>
</tr>
<tr>
<td></td>
<td>89502</td>
<td>COST SHARING-DIRECT</td>
<td>0.00</td>
</tr>
<tr>
<td>370100 Total</td>
<td></td>
<td></td>
<td>1,146,744.12</td>
</tr>
</tbody>
</table>

7. As you work with Pivot Tables, you’ll decide which layout you like to use. For now, let’s return to the Compact Form.

**Expanding/Collapsing Fields**

In the Pivot Table you can display as much or as little detail as you want. Suppose we are sending a copy of this PivotTable to a select group, however, not everyone needs all the levels.
1. Place the cursor on any Object Code Number.

2. Open the Options tab under PivotTable Tools.

3. In the Active Field Group, click on Collapse Entire Field.

4. Results:

5. To see the detail again, click on Expand Entire Field.
6. We can do the same with the Organization. Place the cursor on an Organization Number.

7. Click on .

8. To expand, click on .

9. You can also expand or collapse individual items within a field.
   a. Next to each item in a field is icon. Click on this icon next to Object Code Number 84108.
10. The individual field item collapsed.

11. The icon changes to ![icon]. The amount becomes bold indicating a subtotal. Just click on the plus icon to expand it again.

### Adding a field to the Columns

Let’s say we want to see the charges for each object code across periods. Period needs to be in the columns.

1. Select Period Name from the Field List.

2. Since period name is a text/character, it automatically moves to the Row Labels. Click on the down arrow next Period Name in the Row Labels.
3. Select “Move to Column Labels” from the list.

4. The Period Name is now in the columns.

5. The periods are in alphabetical order and we want them in Fiscal Year Order. To correct the order let’s add Period Number. Note: Period Number only applies to data from a query in the Data Warehouse.

6. Period Number is numeric so it will automatically move to the Values pane. Click on the down arrow to select “Move to Column Labels”. Once it is in the Column Labels, be sure to move it up to the top.
7. Results:

<table>
<thead>
<tr>
<th>Sum of Functional Net Activity</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>159</td>
</tr>
<tr>
<td>570100</td>
<td>69,999.75</td>
</tr>
<tr>
<td>84104</td>
<td>4,802.95</td>
</tr>
<tr>
<td>84106</td>
<td>5.49</td>
</tr>
<tr>
<td>84108</td>
<td>291.10</td>
</tr>
</tbody>
</table>

**Pivot Table Styles Options**

1. We have good information here, but it is hard to follow all these numbers. Let’s see how we can make reading the Pivot Table a little easier.

2. Let’s open the **Options** tab under PivotTable Tools.

3. In PivotTable Style options, click into the box next to Banded Columns.

4. Even columns are formatted differently from odd columns.

5. If you prefer, you can select Banded Rows instead.
6. For this PivotTable, Banded Columns may be preferred.

**Pivot Table Styles**

Just like any Excel table, you can change the table style on a Pivot Table.

1. Open the design tab under PivotTable Tools.

2. On this tab is a group called PivotTable Styles.

3. Click on to open the styles list.
a. The styles are divided into Light, Medium and Dark. You’ll have to scroll down to see the Dark styles.

b. As you hover on each style, Excel will preview the style on your pivot table.

c. You can enhance the style by using the Banded Rows or Banded Columns. Below I’ve elected to use Banded Columns.
Adding a field to the Report Filter

1. Perhaps we would like a separate pivot report for each organization. We can accomplish that with the Report Filter. Move the Organization Number to the Report Filter. How do I do that?

2. Once the Organization Number is moved to the Report Filter, (All) displays in the filtered field. This indicates that the amounts in the PivotTable are summaries of all the organizations.

1. As mentioned before, all work can be done in the PivotTable field list. Let’s select a single organization.
   
a. Go to the Organization Number field in the Field List and click on the down arrow to the right of the field name.

b. The Organization filter will open.

Choosing “Select Multiple Items” summarizes amounts for all items selected.
c. Highlight organization 370100 and click on the **OK** button.

![Organization Number](image)

| Sum of Functional Net Activity | Column Labels
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Labels</td>
<td>Jul10-11  Aug10-11  Sep10-11</td>
</tr>
<tr>
<td>84104</td>
<td>4,802.95  11,463.75</td>
</tr>
<tr>
<td>COMPUTING SUPPLIES</td>
<td>5.49  423.13  2,100.47</td>
</tr>
<tr>
<td>84105</td>
<td>5.49  423.13  2,100.47</td>
</tr>
<tr>
<td>OFFICE SUPPLIES</td>
<td>291.10  998.90  1,342.05</td>
</tr>
<tr>
<td>84109</td>
<td>291.10  998.90  1,342.05</td>
</tr>
<tr>
<td>PAPER SUPPLIES</td>
<td>291.10  998.90  1,342.05</td>
</tr>
<tr>
<td>84110</td>
<td>291.10  998.90  1,342.05</td>
</tr>
<tr>
<td>CLEANING/CUSTODIAL SUPPLIES</td>
<td>11.50  74.90  5.52</td>
</tr>
</tbody>
</table>

a. The amounts now reflect only the organization selected. The icon in the Report Filter field changed to ![icon](image) indicating a value was selected.

b. In addition, a filter icon appears next to the Organization number in the PivotTable field list.

d. Let’s change the filter back to include all the Organizations.
e. Open the filter again by clicking on the down arrow to the right of the field name.

![filter](image)
f. Select (All) by clicking on it which highlights it.
g. Click on the **OK** button.

2. The Report Filter once again displays an (All) in the value field.

   ![Organization Number Filter](image1.png)

3. You can also use the Report Filter to select a single organization. Click on the filter icon to the right of All.

   ![Filter Icon](image2.png)

4. The same Organization Number filter displays. Select organization 370100 and click on the **OK** button.

   ![Pivot Table Field List](image3.png)

5. The amounts in the Pivot Table only reflect Organization 370100 and the filter icon appears next to organization number in the field list.
6. Open the filter and select All again.

7. The filter now says all again and the icon no longer displays next to Organization Number on the Field List.

8. Suppose you want to be able to see a pivot table for each organization simultaneously. You want to do some comparisons.

9. Open the options tab and click on the Options function in the Pivot Table grouping.

10. Three options will display.

11. Select the option “Show Report Filter Pages…”.
12. The **Show Report Filter Pages** opens displaying all the fields currently in my report filter. In this example I have only one field, Organization Number.

![Show Report Filter Pages](image)

13. Click on the **OK** button.

14. Excel creates a pivot table for each of the Organizations and places them in individual worksheets.

![Pivot Table](image)

15. The worksheet tabs will be labeled accordingly.

16. Go back to your **370100** tab.

![Pivot Table Field List](image)

17. Notice you still have the filter available you can filter on another organization without switching tabs.

**More Filtering for the Pivot Table**

1. We can narrow down the information we see by filtering on another field in the PivotTable Field List.

2. For this example, let’s retrieve all Object Code Numbers that begin with 85.

3. Go to Object Code number in the PivotTable Field List.
4. Click on the down arrow to open the Object Code Number filter.

5. The Object Code Number is in the Row Labels on the Pivot Table so we want to use the Label Filters.

6. We want to get all the Object Codes that begin with 85, so we’ll select the filter operator “Begins with…”

7. Enter 85 in the field to the right of the Filter Operator and click on the button.

8. Only Object Code Numbers beginning with 85 are in the PivotTable.

9. Perhaps we only want to see the 2nd quarter which consists of Oct, Nov and Dec.
10. For this one, let’s use the **Column Labels** filter. Click on it.

   ![Column Labels](image)

   a. There are multiple fields in the columns so at the top you would select a field. The field we want is already selected – Period Number.

   b. Our field is in the Column Labels so we are going to use Label Filters to narrow down our search. Click on **Label Filters**.

   ![Label Filters](image)
a. Selecting between would allow us to enter the beginning and ending period number for the 2nd quarter. I can look at the top of my columns in the Pivot Table and see that the Period Numbers for the 2nd quarter are 162 (Oct10-11) through 164 (Dec10-11).

![Image of Label Filter dialog box]

b. Results: Only three periods are now included in the Pivot Table.

![Image of Pivot Table with filtered periods]

11. Another option is to filter on a period name.

12. Let’s clear the filter on the Period Number first. Click on the Column Label Filter.

13. Click on Label Filters.
a. Select Clear Filter.

b. Columns are no longer filtered.

14. Now let’s filter on Period Name.

a. Open the Column Labels

b. Click on the filter icon for the Field.

c. Select Period Name.
d. The list is now by Period Name.

e. Now you can select each month individually but first you must unselect All by unchecking the box for (Select All).

![Select Field](image)

f. Click on the box next to each period you want to retrieve. For the 2\textsuperscript{nd} Qtr, select Oct10-11, Nov10-11 and Dec10-11.

g. Click on the **OK** button.

![Sum of Functional Net Activity](image)

15. So we’ve narrowed down our data to one organization, which is 370100, object codes that start with 85 and the timeframe is the 2\textsuperscript{nd} quarter. So in my analysis, I’m looking at the numbers to see if there is anything that requires further inspection.
16. So I’ve scrolled down and found Object Code 85162 to be a rather large number in Dec10-11. How can I find out what is included in that amount?

**Drilling to the Detail**

1. I can choose to retrieve the detail for an individual period such as Dec10-11 or I can retrieve the detail for all three periods. Why don’t we go for all three periods? Double-click on the Grand Total amount of 10,679.54.

![Excel table](image)

2. Excel extracts the appropriate transactions and places them in a separate worksheet. I’ve hidden most of the columns here. You can instantly have the detail to any amount on the PivotTable.

Close all files before proceeding to the next section. Don’t save.
Non-Financial Data

VLookup and Pivot Tables can also be used for Non-Financial Data. For non-financial data a different type of VLookup may be applicable.

Let’s open the folder titled Non-Financial Data. In it is one Excel workbook titled Non Financial Data.xlsx. Open this workbook.

In this file are two worksheets, Potential Donor Listing and Gift Groupings. This data is from the Advance system and is information about potential donors.

Open the Potential Donor Listing Tab. The worksheet looks like this:

<table>
<thead>
<tr>
<th>DONOR ID_NBR</th>
<th>RATING</th>
<th>STAGE</th>
<th>CLAN_REGION</th>
<th>NETWORTH</th>
<th>PROSPECT MANAGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>92</td>
<td>N1: $50K-$99K</td>
<td>1-Qualification</td>
<td>NY - New York City</td>
<td>$10,000 - $24,999</td>
<td>Maggie Murph</td>
</tr>
<tr>
<td>102</td>
<td>N1: $50K-$99K</td>
<td>1-Qualification</td>
<td>New York City</td>
<td>$10,000 - $24,999</td>
<td>Nancy Johnson</td>
</tr>
<tr>
<td>143</td>
<td>P1: $10K-$199K</td>
<td>2-Cultivation</td>
<td>$500,000 - $999,999</td>
<td>Ben Dover</td>
<td></td>
</tr>
<tr>
<td>296</td>
<td>O1: $25K-$49K</td>
<td>1H-REP</td>
<td>$25,000 - $49,999</td>
<td>Sam E William</td>
<td></td>
</tr>
<tr>
<td>733</td>
<td>N1: $50K-$99K</td>
<td>1H-REP</td>
<td>Greater Than $1M</td>
<td>Sam E William</td>
<td></td>
</tr>
<tr>
<td>805</td>
<td>O1: $25K-$49K</td>
<td>2-Cultivation</td>
<td>Greater Than $1M</td>
<td>Ben Dover</td>
<td></td>
</tr>
<tr>
<td>1015</td>
<td>N1: $50K-$99K</td>
<td>2-Cultivation</td>
<td>IN - Indianapolis</td>
<td>$250,000 - $499,999</td>
<td>Ben Dover</td>
</tr>
</tbody>
</table>

Each year a rating called EVI is calculated for each potential donor. Scroll to the right to see the column called EVI YEARLY RATING 1-100. The number in this column can be anything from 1 to 100.

We want to place these potential donors in the following groupings called UA Group:

- D = 90-100
- C = 80-89
- B = 70-79
- A = 60-69

Switch to the tab labeled Gift Groupings. The worksheet looks like this:

<table>
<thead>
<tr>
<th>Avg. Amount</th>
<th>Grouping</th>
<th>Total Amt</th>
<th>Grouping</th>
<th>VOL_COUNT</th>
<th>Grouping</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>1</td>
<td>1.00</td>
<td>1</td>
<td>1.00</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>3.00</td>
<td>2</td>
<td>2.00</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>5.00</td>
<td>4</td>
<td>5.00</td>
<td>4</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>6.00</td>
<td>5</td>
<td>6.00</td>
<td>5</td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>8.00</td>
<td>7</td>
<td>8.00</td>
<td>7</td>
</tr>
<tr>
<td>10</td>
<td>8</td>
<td>10.00</td>
<td>8</td>
<td>10.00</td>
<td>8</td>
</tr>
<tr>
<td>12</td>
<td>9</td>
<td>12.00</td>
<td>9</td>
<td>12.00</td>
<td>9</td>
</tr>
<tr>
<td>14</td>
<td>10</td>
<td>14.00</td>
<td>10</td>
<td>14.00</td>
<td>10</td>
</tr>
<tr>
<td>16</td>
<td>11</td>
<td>16.00</td>
<td>11</td>
<td>16.00</td>
<td>11</td>
</tr>
<tr>
<td>18</td>
<td>12</td>
<td>18.00</td>
<td>12</td>
<td>18.00</td>
<td>12</td>
</tr>
</tbody>
</table>

60
This worksheet has several groupings. The group we are interested in, is the last grouping on the right. Instead of having an exact match for our VLookup we will be using a range; therefore it will be an approximate match.

**VLookup (for a range)**

1. Go back to the Potential Donor Listing. Insert a column to the right of EVI_YEARLY RATING 1-100.
   a. Highlight the column next to EVI_YEARLY RATING 1-100 titled COLLEGE1, column N.
   b. On the **Home** tab, click on the **Insert** command in the cells grouping.
   c. Select “Insert Sheet Columns”

2. Title column N “UA GROUP”.

<table>
<thead>
<tr>
<th>M</th>
<th>N</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVI YEARLY</td>
<td>UA GROUP</td>
<td>COLLEGE</td>
</tr>
<tr>
<td>RATING 1-100</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>76</td>
<td></td>
<td>CIT</td>
</tr>
<tr>
<td>66</td>
<td></td>
<td>CIT</td>
</tr>
<tr>
<td>93</td>
<td></td>
<td>CIT</td>
</tr>
<tr>
<td>711</td>
<td></td>
<td>CIT</td>
</tr>
</tbody>
</table>

3. Click into the first cell in the new column (UA GROUP).

4. Open the **Formulas** tab.
5. This time open the Recently Used category.

6. Functions that you’ve used are placed in the recently used. Since we just used VLOOKUP, it is at the top of the list.

7. The Function Arguments form will open.

8. The Lookup value will be the first value in the EVI YEARLY RATING 1-100 column. Click on that first value.
9. A dotted line appears around the cell containing the value. The location of the cell is placed in the Lookup_value field. The value in the cell is displayed to the right of the field.

10. Click in the Table_array field, then open the worksheet tab.

11. Go to the EVI Start. This grouping starts all the way over in Column J.

12. Our Lookup value in this file will be the EVI Start value, therefore the start value must be our first column in the Table_array.
13. Click into the Column J designator to see the cursor change into a black down arrow.

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVI Start</td>
<td>EVI End</td>
<td>UA GROUP</td>
</tr>
<tr>
<td>1</td>
<td>69 A</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>79 B</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>89 C</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>100 D</td>
<td></td>
</tr>
</tbody>
</table>

14. Hold the mouse key down and move to column L.

15. The data we want is in the 3\textsuperscript{rd} column of our Table\_array.

16. Click into the Col\_index\_num field. Enter a 3.

17. Click in the Range\_lookup field.
18. Our result should be “B” for the EVI YEARLY RATING 1-100

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>N</td>
</tr>
<tr>
<td>EVI YEARLY RATING 1-100</td>
<td>UA GROUP</td>
</tr>
<tr>
<td>76</td>
<td>B</td>
</tr>
</tbody>
</table>

19. In this case, we are not searching for an exact value, so you can leave the field blank, enter the word true or enter a 1 (as shown here) which translates to true.

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVI Start</td>
<td>EVI End</td>
<td>UA GROUP</td>
</tr>
<tr>
<td>1</td>
<td>69 A</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>79 B</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>89 C</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>100 D</td>
<td></td>
</tr>
</tbody>
</table>

Value 76 is not in the table array, so it uses the next largest value that is less than or equal to 76. 70 is less than 76 so it selects the UA GROUP of B.

20. Copy the formula down the rows in the column.

21. If you need to enter a new range in the UA Group, the Lookup value column (in this example, EVI Start) must be in order (numeric/character). **For instance, let’s say we add a new range of 60-69 = E, the file should look like this:**

<table>
<thead>
<tr>
<th>J</th>
<th>K</th>
<th>L</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVI Start</td>
<td>EVI End</td>
<td>UA GROUP</td>
</tr>
<tr>
<td>1</td>
<td>59 A</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>69 E</td>
<td></td>
</tr>
<tr>
<td>70</td>
<td>79 B</td>
<td></td>
</tr>
<tr>
<td>80</td>
<td>89 C</td>
<td></td>
</tr>
<tr>
<td>90</td>
<td>100 D</td>
<td></td>
</tr>
</tbody>
</table>

22. The Lookup value is in numerical order. Now look at the UA GROUP column in the Potential Donor Listing worksheet.

<table>
<thead>
<tr>
<th>M</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVI YEARLY RATING 1-100</td>
<td>UA GROUP</td>
</tr>
<tr>
<td>76</td>
<td>B</td>
</tr>
<tr>
<td>86</td>
<td>E</td>
</tr>
<tr>
<td>93</td>
<td>D</td>
</tr>
<tr>
<td>71</td>
<td>B</td>
</tr>
<tr>
<td>10</td>
<td>A</td>
</tr>
<tr>
<td>93</td>
<td>D</td>
</tr>
</tbody>
</table>
Pivot Table

Now let’s look at how Pivot Tables might be used with non-financial data.

Do you remember how to start the Pivot Table?

**Starting the Pivot Table**

1. Click anywhere in the data.

2. Go to the ribbon and open the **Insert** tab. Click on the PivotTable icon.

3. Accept the defaults on the Create PivotTable form by clicking on the **OK** button.
4. Excel opens a new worksheet so we can begin creating our Pivot Table.

**Creating a Simple Pivot Table**

When dealing with non-financial data, rather than summarizing the data, the analysis is more geared to counting.

For instance, in the file are potential donors, in fact there are 1,844 potential donors. Each donor has a unique ID number. Each donor is assigned to a prospect manager. Suppose we wanted to see how many donors each manager has.

1. Select the Prospect Manager by clicking in the box to the left of Prospect Manager in the PivotTable Field List.

   ![PROSPECT MANAGER](image)

2. Prospect Manager is a character field so Excel placed it in the Row Labels and the Prospect Manager is now in the Pivot Table.
3. We want to know how many donors each Prospect Manager has. Let’s select the field DONOR ID_NBR.

4. Selecting the DONOR ID_NBR caused the following to happen:

   a. The field name became bold as shown above.

   b. Because DONOR ID_NBR is numerical, Excel dropped the field into the Values pane.
c. Excel also summed the DONOR ID NBR for each Prospect Manager as shown in the Pivot Table.

<table>
<thead>
<tr>
<th>Row Labels</th>
<th>Sum of DONOR ID_NBR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ben Dover</td>
<td>14555677</td>
</tr>
<tr>
<td>Maggie Murph</td>
<td>36476813</td>
</tr>
<tr>
<td>Nancy Johnson</td>
<td>31565079</td>
</tr>
<tr>
<td>Sam E Williams</td>
<td>36302379</td>
</tr>
<tr>
<td>Scott E. Dawg</td>
<td>13880988</td>
</tr>
<tr>
<td>Tina Tartan</td>
<td>12745191</td>
</tr>
<tr>
<td><strong>Grand Total</strong></td>
<td><strong>145526127</strong></td>
</tr>
</tbody>
</table>

5. The summing function is not meaningful to this data. We really want to count the number of donors each prospect manager has.

6. In the Values pane, click on the down arrow to the right of the Sum of DONOR ID_NBR

7. A list of options for this field will display.

8. Select Value Field Settings...
9. From the list of available calculations, highlight *Count*.

10. Click on the **OK** button.

11. We now know how many donors assigned to each manager.

*Adding Another Field*

12. Let’s add the UA GROUP to the Pivot Table.
13. The UA GROUP now appears in the Pivot Table.

14. Let’s move the UA GROUP to the Column Label. Do you remember how?

15. The #N/A column consists of donors that had a zero in the EVI YEARLY RATING 1-100 column. Perhaps for this analysis we want to exclude the #N/A column.

   a. Go to the PivotTable Field List click the down arrow to the right of the field name UA GROUP.
b. Click in the box next to #N/A to unselect it.

c. Notice that the box preceding (Select All) is automatically unchecked.

d. Click on the [OK] button.

e. The #N/A column is gone and the totals are adjusted.

f. The filter icon appears next to the UA GROUP field.

16. Let’s take a look at the potential donors under Maggie Murph. Do you remember how to view the details that make up 227 in the Grand Total?

Thank you for attending the Excel Advanced Training. For additional training opportunities, please visit https://www.cmu.edu/finance/training/index.html